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XGT/XGB Series Cnet Driver

Introduction
This manual describes how to connect the Display and the External Device (target PLC).
In this manual, the connection procedure will be described by following the below sections:

1 || System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

&g System Configuration" (page 3)

2 Selection of External Device =
Select a model (series) of the External
Device to be connected and connection
method.

"2 Selection of External Device" (page 7)

3 Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

&3 Example of Communication Setting"
(page 8)

4 Setup ltems

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro Ex or in offline mode.

Fny Setup Items" (page 30)

5 || Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

&5 Cable Diagram” (page 35)

Operation
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XGT/XGB Series Cnet Driver

1 System Configuration
The system configuration in the case when the External Device of LS Industrial Systems Co., Ltd. and the Display
are connected is shown.
Settin Cable
Series CPU Link I/F SIO Type nd .
Example Diagram
CH1 port on XGL-C22A | RS232C Setting Example 1" | "Cable Diagram 1
(page 8) (page 35)
) "Setting Example 2" | "Cable Diagram 1"
CH2 port on XGL-C22A |RS232C (page 10) (page 35)
) RS422/485 "Setting Example 3" | "Cable Diagram 2"
CH1 port on XGL-C42A (4 wire) (age 12) (page 37)
) RS422/485 "Setting Example 5" | "Cable Diagram 3"
XGK-CPUE CHI porton XGL-C42A (2 wire) (page 16) (page 44)
XGK-CPUS p—— e : .
XGK |XGK-CPUA | CH2 port on XGL-C42A Zsﬁrze/)“% (Sgtte'”&)Examp'e 4 (Caab(:%?D)'agram 2
XGK-CPUH pag pag
XGK-CPUU ) RS422/485 "Setting Example 6" | "Cable Diagram 3"
CH2 port on XGL-C42A 2 wire) (page 18) (age 44)
CH1 port on XGL-CH2A | RS232C Setting Example 1" | "Cable Diagram 1
(page 8) (page 35)
RS422/485 "Setting Example 4" | "Cable Diagram 2"
CH2 port on XGL-CH2A (4 wire) (page 14) (age 37)
) RS422/485 "Setting Example 6" | "Cable Diagram 3"
CH2 port on XGL-CH2A 2 wire) (page 18) (age 44)
"Setting Example 7" | "Cable Diagram 4"
CH1 port on CPU RS232C (page 20) (page 49)
CH2 port on CPU ZS;?rZBI;SS (Saettengz)Example 8 (Caabele5 (I)D)lagram 5
XBM-DR**S Pag pag
XBM-DN**S i "Setting Example 9" | "Cable Diagram 1"
XGB XBC-DR**H XBL-C21A RS232C (page 24) (page 35)
_ *%x
XBC-DN**H XBL-CA1A RS422/485 "Setting Example "Cable Diagram 2"
(4 wire) 10" (page 26) (page 37)
RS422/485 "Setting Example "Cable Diagram 3"
XBL-CAIA (2 wire) 11" (page 28) (page 44)
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XGT/XGB Series Cnet Driver
|

B Connection Configuration

» 1:1 Connection

)

)

External Device

Display

¢ 1:n Connection

External Device External Device External Device

u J

Display The max numbgr of Display: 16
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B |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

XGT/XGB Series Cnet Driver

Usable port
) Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)
com1™, comz,
PS-2000B Com3*L coma - .
PS-3450A, PS-3451A, % * qxo
PS3000-BA, PS3001-BD COMIL, COM2 com2 com2
PS-3650A (T41 model), 1 ] ]
PS-3651A (T41 model) coMl
PS-3650A (T42 model), % % 2
PS-3651A (T42 model) com1™t*2 com2 COM1 CcCoM1
PS-3700A (Pentium®4-M) | COM1™, com2™, 2 o
PS-3710A COM3™2, coM4 com3 CoM3
PS-3711A comM1™ com2™ CoM2™2 COM2*?
PS4000™3 COM1, COM2 - -
com1™2 com2™, 1% %
PL3000 COM3, COM4 coM1 CcCoM1

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

DIP Switch setting: RS-232C

DIP Switch Setting Description
1 OFF™1 Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.
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XGT/XGB Series Cnet Driver

DIP Switch setting: RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON
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XGT/XGB Series Cnet Driver

2 Selection of External Device

Select the External Device to be connected to the Display.

&% Welcome to GP-Pro EX E

— Device/PLC
Mumber of Devices/PLCs Iﬁ.
Device/PLC 1
Manufacturer | LS Industrial Systems Co., Ltd, |L
Series GT/XGE Series Cet [+
Fart COM1 [+
Eefer to the manual of this Device/PLC
Eecent Device/PLC
4 L
I Use Spstem Area Drevice Information

Back [B] | Communication Settings Hew Logic | Mew Screen I Cancel

Setup Items Setup Description

Number of Devices/ Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

PLCs
Select the manufacturer of the External Device to connect. Select “LS Industrial Systems Co.,
Manufacturer Lid."
Select the External Device model (series) and the connection method. Select "XGT/XGB
Series Cnet".
Series In System configuration, make sure the External Device you are connecting is supported by
"XGT/XGB Series Cnet".
] System Configuration” (page 3)
Port Select the Display port to connect to the External Device.

Check this option to synchronize the system data area of the Display and the device (memory)
of the External Device. When synchronized, you can use the External Device’s ladder program
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area]

Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"

Use System Area

GP-Pro EX Device/PLC Connection Manual 7



XGT/XGB Series Cnet Driver

3 Example of Communication Setting

The following shows examples of communication settings of the Display and the External Device, which is
recommended by Pro-face.
3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |

Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T Change

Communication Settings

SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /WCC + Rl " WCC

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C

Isolation Unit, please select it to WCC. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4ET Station No.=0

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies (¢ ®GT " XGE

Station Mo. a 3:
Default

oK@ | Cancel |
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XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 Select base and slot which using module is connected from [Standard settings] tab in offline, and [Communication
Module Settings] dialog box is displayed.

3 Select “Cnet” from [Type], and click [OK].

4 Select [Connect] from [Online] menu.

5 Select [Read 10 Information] from the [Online] menu.

6 Double click [Cnet] from the [Standard settings] tab, and [Standard Settings-Cnet] dialog box is displayed.

7 Set [Channel 1] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS232C
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

8 Select [Write Parameter] from the [Online] menu, and [Write Parameter] dialog box is displayed.
9 Select using module, and click [OK].
10 select [Reset] from the [Online] menu.

GP-Pro EX Device/PLC Connection Manual 9



XGT/XGB Series Cnet Driver

3.2 Setting Example 2
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T Change
Communication Settings
SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =
Data Length 7 (O]
Parity (+ NOME " EVEM " ooD
Stop Bit 1 2
Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF
Timeout 3 3: [zec)
Fietry 2 3:
‘Wait To Send 1] 3: [mz]
Rl /WCC + Rl " WCC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Alloweable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
1 [PLcT [l [Series=4ET Station No.=0

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings
PLC1

Senies (¢ ®GT " XGE

a El:
Default

oK () |

Station Mo.

Cancel |
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XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 Select base and slot which using module is connected from [Standard settings] tab in offline, and [Communication
Module Settings] dialog box is displayed.

3 Select “Cnet” from [Type], and click [OK].

4 Select [Connect] from [Online] menu.

5 Select [Read 10 Information] from the [Online] menu.

6 Double click [Cnet] from the [Standard settings] tab, and [Standard Settings-Cnet] dialog box is displayed.

7 Set [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS232C
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

8 Select [Write Parameter] from the [Online] menu, and [Write Parameter] dialog box is displayed.
9 Select using module, and click [OK].
10 select [Reset] from the [Online] menu.

GP-Pro EX Device/PLC Connection Manual 11



XGT/XGB Series Cnet Driver

3.3 Setting Example 3
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C " RS422/485(2wire) (+ RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GT Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies (¢ ®GT " XGE

Station Mo. a 3:
Default

oK@ | Cancel |

GP-Pro EX Device/PLC Connection Manual 12



XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 Select base and slot which using module is connected from [Standard settings] tab in offline, and [Communication
Module Settings] dialog box is displayed.

3 Select “Cnet” from [Type], and click [OK].

4 Select [Connect] from [Online] menu.

5 Select [Read 10 Information] from the [Online] menu.

6 Double click [Cnet] from the [Standard settings] tab, and [Standard Settings-Cnet] dialog box is displayed.

7 Set [Channel 1] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

8 Select [Write Parameter] from the [Online] menu, and [Write Parameter] dialog box is displayed.
9 Select using module, and click [OK].
10 select [Reset] from the [Online] menu.

GP-Pro EX Device/PLC Connection Manual 13



XGT/XGB Series Cnet Driver

3.4 Setting Example 4
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C " RS422/485(2wire) (+ RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GT Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies (¢ ®GT " XGE

Station Mo. a 3:
Default

oK@ | Cancel |

GP-Pro EX Device/PLC Connection Manual 14



XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 Select base and slot which using module is connected from [Standard settings] tab in offline, and [Communication
Module Settings] dialog box is displayed.

3 Select “Cnet” from [Type], and click [OK].

4 Select [Connect] from [Online] menu.

5 Select [Read 10 Information] from the [Online] menu.

6 Double click [Cnet] from the [Standard settings] tab, and [Standard Settings-Cnet] dialog box is displayed.

7 Set [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

8 Select [Write Parameter] from the [Online] menu, and [Write Parameter] dialog box is displayed.
9 Select using module, and click [OK].
10 select [Reset] from the [Online] menu.

GP-Pro EX Device/PLC Connection Manual 15



XGT/XGB Series Cnet Driver

3.5 Setting Example 5
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C (+ RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GT Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies (¢ ®GT " XGE

Station Mo. a 3:
Default

oK@ | Cancel |
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XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 Select base and slot which using module is connected from [Standard settings] tab in offline, and [Communication
Module Settings] dialog box is displayed.

3 Select “Cnet” from [Type], and click [OK].

4 Select [Connect] from [Online] menu.

5 Select [Read 10 Information] from the [Online] menu.

6 Double click [Cnet] from the [Standard settings] tab, and [Standard Settings-Cnet] dialog box is displayed.

7 Set [Channel 1] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

8 Select [Write Parameter] from the [Online] menu, and [Write Parameter] dialog box is displayed.
9 Select using module, and click [OK].
10 select [Reset] from the [Online] menu.

GP-Pro EX Device/PLC Connection Manual 17



XGT/XGB Series Cnet Driver

3.6 Setting Example 6
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C (+ RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GT Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies (¢ ®GT " XGE

Station Mo. a 3:
Default

oK@ | Cancel |

GP-Pro EX Device/PLC Connection Manual 18



XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 Select base and slot which using module is connected from [Standard settings] tab in offline, and [Communication
Module Settings] dialog box is displayed.

3 Select “Cnet” from [Type], and click [OK].

4 Select [Connect] from [Online] menu.

5 Select [Read 10 Information] from the [Online] menu.

6 Double click [Cnet] from the [Standard settings] tab, and [Standard Settings-Cnet] dialog box is displayed.

7 Set [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

8 Select [Write Parameter] from the [Online] menu, and [Write Parameter] dialog box is displayed.
9 Select using module, and click [OK].
10 select [Reset] from the [Online] menu.

GP-Pro EX Device/PLC Connection Manual 19



XGT/XGB Series Cnet Driver

3.7 Setting Example 7
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T Change
Communication Settings
SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =
Data Length 7 (O]
Parity (+ NOME " EVEM " ooD
Stop Bit 1 2
Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF
Timeout 3 3: [zec)
Fietry 2 3:
‘Wait To Send 1] 3: [mz]
Rl /WCC + Rl " WCC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Alloweable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
1 [PLcT [l [Series=4GE Station No.=0

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings
PLC1

Senies " ®GT (¥ XGB

a El:
Default

oK () |

Station Mo.

Cancel |

GP-Pro EX Device/PLC Connection Manual 20



XGT/XGB Series Cnet Driver

B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.
2 From the [File] menu, select [New File], and create the XGB project.

NOTE I « To read the project from the External Device, select [Open from PLC...].

3 From the [Online] menu, select [Connect].

4 From the [Online] menu, select [Read 10 Information].

5 In the [Standard settings] tab, double-click [Embedded Cnet] to display the [Standard Settings-Cnet] dialog box.
6 Set the [Channel 1] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS232C
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

7 From the [Online] menu, select [Write Parameter] to display the [Write Parameter] dialog box.
8 Select the module to use, and click [OK].
9 From the [Online] menu, select [Reset].
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3.8 Setting Example 8
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C (+ RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GE Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies " ®GT (¥ XGB

Station Mo. a 3:
Default

oK@ | Cancel |
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B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.
2 From the [File] menu, select [New File], and create the XGB project.

NOTE I « To read the project from the External Device, select [Open from PLC...].

3 From the [Online] menu, select [Connect].

4 From the [Online] menu, select [Read 10 Information].

5 In the [Standard settings] tab, double-click [Embedded Cnet] to display the [Standard Settings-Cnet] dialog box.
6 Set the [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

7 From the [Online] menu, select [Write Parameter] to display the [Write Parameter] dialog box.
8 Select the module to use, and click [OK].
9 From the [Online] menu, select [Reset].
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3.9 Setting Example 9
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T Change
Communication Settings
SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =
Data Length 7 (O]
Parity (+ NOME " EVEM " ooD
Stop Bit 1 2
Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF
Timeout 3 3: [zec)
Fietry 2 3:
‘Wait To Send 1] 3: [mz]
Rl /WCC + Rl " WCC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Alloweable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
1 [PLcT [l [Series=4GE Station No.=0

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings
PLC1

Senies " ®GT (¥ XGB

a El:
Default

oK () |

Station Mo.

Cancel |
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B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.
2 From the [File] menu, select [New File] and create the XGB project.

NOTE I « To read the project from the External Device, select [Open from PLC...].

3 From the [Online] menu, select [Connect].

4 From the [Online] menu, select [Read 10 Information].

5 In the [Standard settings] tab, double-click [Cnet] to display the [Standard Settings-Cnet] dialog box.
6 Set the [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS232C
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

7 From the [Online] menu, select [Write Parameter] to display the [Write Parameter] dialog box.
8 Select the module to use, and click [OK].
9 From the [Online] menu, select [Reset].
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3.10 Setting Example 10
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C " RS422/485(2wire) (+ RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GE Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies " ®GT (¥ XGB

Station Mo. a 3:
Default

oK@ | Cancel |
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B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.
2 From the [File] menu, select [New File], and create the XGB project.

NOTE I « To read the project from the External Device, select [Open from PLC...].

3 From the [Online] menu, select [Connect].

4 From the [Online] menu, select [Read 10 Information].

5 In the [Standard settings] tab, double-click [Cnet] to display the [Standard Settings-Cnet] dialog box.
6 Set the [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

7 From the [Online] menu, select [Write Parameter] to display the [Write Parameter] dialog box.
8 Select the module to use, and click [OK].
9 From the [Online] menu, select [Reset].

GP-Pro EX Device/PLC Connection Manual 27



XGT/XGB Series Cnet Driver

3.11 Setting Example 11
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type " RS232C (+ RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /LT O -

I the case of RE232EC, pou can select the Sth pin to Bl [Input)
or WL (5% Power Supply). IF you uze the Digital's B5232C

|zolation Unit, please select it to WYLL. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
1 [P [l [Series=4GE Station No.=0 G

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

i;lndividual Device Settings
PLCA

Senies " ®GT (¥ XGB

Station Mo. a 3:
Default

oK@ | Cancel |
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B Settings of External Device
Use the LS Industrial Systems setting tool (XG-PD Editor) to configure communication settings for the External
Device.

Refer to your External Device manual for details.

1 Start up the setting tool.
2 From the [File] menu, select [New File], and create the XGB project.

NOTE I « To read the project from the External Device, select [Open from PLC...].

3 From the [Online] menu, select [Connect].

4 From the [Online] menu, select [Read 10 Information].

5 In the [Standard settings] tab, double-click [Cnet] to display the [Standard Settings-Cnet] dialog box.
6 Set the [Channel 2] setup items as follows, and click [OK].

Setup Item Setting Value
Type RS485
Speed 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE
Modem Type Null Modem
Station 0
Active mode XGT server

7 From the [Online] menu, select [Write Parameter] to display the [Write Parameter] dialog box.
8 Select the module to use, and click [OK].
9 From the [Online] menu, select [Reset].

GP-Pro EX Device/PLC Connection Manual 29



XGT/XGB Series Cnet Driver
4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.
The setting of each parameter must be identical to that of External Device.
&3 Example of Communication Setting" (page 8)

4.1 Setup Items in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary Change Device/PLC
M anufacturer |LS Industrial Systems Co., Ltd. Series #GT /<GB Senies Cnet Port  |COR1
Text Data Mode ’T LChange

Communication Settings

SI0 Type + RS232C " RS422/485(2wire) " RS422/485(4wire)
Speed 38400 =

Data Length 7 (O]

Parity (+ NOME " EVEM " ooD

Stop Bit 1 2

Flow Contral (+ NOME " ER[DTR/CTS) " XON/HOFF

Timeout m [zec)

Fietry m

Wait Ta Send [0 =ms

Rl /WCC + Rl " WCC

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C

Isolation Unit, please select it to WCC. Default

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Mo, Device Mame Seftings ggﬂilcnedimd
1 [P [l [Series=4ET Station No.=0
Setup ltems Setup Description
SIO Type Select the SI10 type to communicate with the External Device.
Speed Select speed between the External Device and the Display.
Data Length Select data length.
Parity Select how to check parity.
Stop Bit Select stop bit length.

Select the communication control method to prevent overflow of transmission and

Flow Control reception data.
' Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
In case of no response from the External Device, use an integer from 0 to 255 to enter how
Retry . - .
many times the Display retransmits the command.
Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.
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Setup ltems Setup Description

You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE » Refer to the GP-Pro EX Reference Manual for Indirect Device.
Cf.  GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

B Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

i; Individual Device Settings B3

PLC1

Erize & HET  HEB

Station Mo. I a 3:
Default |

oK@ | Cancel |

Setup Items Setup Description

Series Select the series of the External Device.

. Use an integer from 0 to 31 to enter the Station No. of the External Device. (Initial value
Station No. [on)
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4.2 Setup Items in Offline Mode

« Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode

or about the operation.

Cf.  Maintenance/Troubleshooting Guide "Offline Mode"

« The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

| Cormm, Device Option

HGT/HGE Series Gnet [GOM1] Page 1/1
510 Type RS2520 =
Speed J64iR =
Data Length L i * 8
Parity + NONE o EVEN © DD
Stop Bit o »
Flow Control [ NONE >
Timeout(s) j ¥ a
Retry 7w | A
Wait To Send{ms) iw| a
: 2011/12/25
| Enit | . 23:37:47
Setup Items Setup Description
Select the S10 type to communicate with the External Device.
IMPORTANT
To make the communication settings correctly, confirm the serial interface specifications of
SIO Type Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does not
support is specified.
For details concerning the serial interface specifications, refer to the manual for Display
unit.
Speed Select speed between the External Device and the Display.

Data Length

Select data length.

Parity Select how to check parity.
Stop Bit Select stop bit length.

Select the communication control method to prevent overflow of transmission and reception
Flow Control

data.
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Setup Items Setup Description
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout (s) .
response from the External Device.
Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.

Wait To Send (ms)

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.

B Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the

External Device you

want to set from the displayed list, and touch [Device].

Cormm, Device Option
HGT/HGB Series Cnet [GOM1] Page 1/1
Device/PLC Name  [PLCI >
Series HGT
Station No. [ hw|a
: 2011412425
Bt . 23:37:54

Setup Items

Setup Description

Device/PLC name [PLC1])

Select the External Device to set. The device name is set up in GP-Pro EX. (Initial value

Series

Display the series of the External Device.

Station No.
(oD

Use an integer from 0 to 31 to enter the Station No. of the External Device. (Initial value
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the
External Device you want to set from the displayed list, and touch [Option].

Setup ltems Setup Description
Switches RI/VCC of the 9th pin.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE I e GP-4100 series and GP-4*01TM do not have the [Option] setting in the offline mode.
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|

5 Cable Diagram

The cable diagram shown below may be different from the cable diagram recommended by LS Industrial Systems

Co., Ltd. Please be assured there is no operational problem in applying the cable diagram shown in this manual.

* The FG pin of the External Device body must be D-class grounded. Please refer to the manual of the External
Device for more details.

* SG and FG are connected inside the Display. When connecting SG to the External Device, design the system
not to form short-circuit loop.

* Connect the isolation unit, when communication is not stabilized under the influence of a noise etc.

Cable Diagram 1

Display

. Cable Notes
(Connection Port)

GP3000 (COM1)
GP4000™! (COM1)
ST (COML1)

LT (COM1)

IPC™2

PC/IAT

1A User-created cable
Cable length: 15m or less

GP-4105 (COM1) 1B User-created cable

*1  All GP4000 models except GP-4100 Series and GP-4203T

*2 O%the COM port which can communicate by RS-232C can be used.
"M |IPC COM Port" (page 5)

1A)
Display side External Device side
D-Sub 9pin (socket) §h_'?_|9‘ D-Sub 9pin (plug)
Pin  |Signal name '," '," \ Pin  |Signal name
Dy [ cD 1 | co
2 |[RDRXD)—F—— 3 | ™D
3 [sp(TxD) » 2 | reD
4 |ER(DTR) o 4 DTR
5 SG 5 | sc
6 |DR(DSR) |—> 6 | DSR
7 |RS(RTS) :I 7 RTS
8 |CS(CTS) LI 8 CTS
Ve ghel
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1B)
Display side External Device side
Terminal block Shield D-Sub 9pin (plug)
Signal name ’,", ','T \ Pin  |Signal name
CcD 1 | cp
Display | RD(RXD) [#——+—F— 3 | TxD
SD(TXD) - » 2 | R
ER(DTR) |— 4 DTR
SG 5 | sG
DR(DSR) b |—> 6 | DSR
RS(RTS) :I 7 RTS
CS(CTS) v 8 | cTs
Ve ghell
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Display
(Connection Port)

Cable

Notes

GP3000" (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
ST™2 (COM2)

LT (COM1)

IPC™3

2A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable

2B

User-created cable

GP3000™ (COM2)

2C

Online adapter by Pro-face
CA4-ADPONL-01
+
Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable

2D

Online adapter by Pro-face
CA4-ADPONL-01
+

User-created cable

GP-4106 (COM1)

2E

User-created cable

GP4000™ (COM2)
GP-4201T (COM1)

2F

RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZCBADTM1"®
+

User-created cable

2B

User-created cable

Cable length: 500m
or less

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3 Ortlgthe COM port which can communicate by RS-422/485 (4 wire) can be used.

"® |IPC COM Port" (page 5)

*4  All GP3000 models except GP-3200 series and AGP-3302B

*5  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

*6  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 2A.
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e 1:1 Connection

Display

XGT/XGB Series Cnet Driver

Display side
Terminal Terminal block ;
resistance . . Exterr.1al Device
120 Q2 (1/2W) Signal name , Shield Terminal block
TERM £ Signal name
/ TR Terminal
CA3-ADPCOM-01 RDA ',.' /"\ T TX+ resistance
RDB : TX- 120 Q (1/2W)
SDA A RX+ Terminal
CA3-ADPTRM-01 % /\i resistance
SDB Y — RX- 120 Q (12W)
SG + — SG
FG I G Y

¢ 1:n Connection

Display

A

User-created cable

Display side

-rESrirgtigr?::e Terminal block External Device External Device
120Q (1/2W) Signal name . Shield Terminal block Shield Terminal block
TERM — ',f' '\‘ Signal name ,/’ '/' '\‘ Signal name

CA3-ADPCOM-01 RDA H—p— TX+ LA TX+

RDB L /\ TX- [ /\] T-

A

CA3-ADPTRM-01 % SoA /\ R /A\ i R

SDB . — RX- ‘ — RX-

SG - sG i sG

FG | i Y

User-created cable

Terminal
resistance

120 Q (12W)
Terminal
resistance
120 Q (1/2W)
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2B)
e 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Shield  Terminal Block
Termination R ] ! ,"\‘ - Termination
resistance | PiN Signal name ! IR Signal name | resistance
120Q 1/2W ! \ 120Q 1/2W
. “ 3 | spa LAY S R
Display ! / ) ‘.| %
7 SDB i RX-
PON
% 1 RDA [« :' / ,\ : TX+ %
i ! 1
< P TX-
Termination 2 RDB E ! Termination
resistance L ! resistance
120Q 1/2W 5 SG E ' SG 120Q 1/2W
4 ERA ‘ b
' oo
8 |csA [+t i i
9 | ERB Voo
\ ]
6 CSB [« \/
\\ \',
Shell -
* 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Shield  Terminal Block ~ Shield  Terminal Block
Termination . i J N - s A i Termination
resistance | PiN Signal name ! ','\‘ Signal name / P Signal name | resistance
Displaymom/zw 3 SDA { /\,",‘l o Rx+ ‘,//\,; s Rx+ 12002 172W
7 SDB ——’ = RX- ' \~—> RX-
g 1 | RDA je—t //\\ ' X+ | /\ — TX+ }

- > | ROB |« i TX- <—|—/ \—— TX- -
Termination 1 ' Vo Termination
resistance 5 SG E SG A - SG  |resistance
1200 1/2W ! N i 1200 1/2W

4 | ERA . -
8 | csaA <J Vo
9 | ERB :I
6 | csB Voo
Shell I -
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2C)
e 1:1 Connection

Display side
:Egg{gﬁ!:e Terminal block External Device
120 Q (1/2W) Signal name Shield Terminal block
Display TERM '/ I/ \‘. Signal name
H FE Terminal
CA4-ADPONL-01 RDA 7 /“\ — TX+ resistance
RDB : TX- 120 Q (1/2W)
A Terminal
CA3-ADPTRM-01 % SDA AV RX* resistance
SDB ¥ — RX- 120 Q (172W)
\ 1
SG + — SG
FG | S — Y
User-created cable
e 1:n Connection
Display side
Terminal Terminal block External Device External Device
120 Q (112W) Signal name Shield Terminal block Shield Terminal block
Displa TERM '/ :’/ \\ Signal name // ,l" 3 Signal name )
B CA4-ADPONL-01 RDA A = X+ f A\ — X+ roumtante
RDB TX- " TX- 120 Q (12W)
SDA A RX+ A RX+ Terminal
CA3-ADPTRM-01 resistance
g SDB : / \,‘ ; RX- + / \ ! RX- 120 Q (12W)
SG SG o T 4 SG
FG L . ¥ et

User-created cable
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2D)

1:1 Connection

Display side
D-Sub 9pin (plu i
- pl (plug) l§b-'§-|c7’\ External Device side
Pin |Signal name ! ! \ Terminal Block
e o [TERMTX{— § {4 |Sonelname | suimomon
Ispiay _l ON Y 120Q 1/2W
3 | SDA [ VA NREN RX+
8 SDB ! » RX-
« A
CA4-ADPONL-01| 2 | RDA [ N TX+ %
7 RDB :I :I ‘: TX- Termination
! \ : resistance
1 |TERMRX | - SG 1200 1/2W
5 | sG TN
Shell  |——%----¥

A

1:n Connection

User-created cable

\ 4

Display side
D-Sub 9pin (plu i
- d - (plug) ,SD-I?-I;-\\ External Device side External Device side
Pin | Signal name ! ! \  TerminalBlock  Shield  Terminal Block
Display 9 TERMTX—l ": .‘: "'. Signal name { A Signal name | 1o aton
N Y NN 1200 1/2W
3 SDA H / ;\ —> RX+ T / '\ —» RX+
8 SDB ' > RX- i > RX-
A « 1
CA4-ADPONL-01| 2 | RDA ¢ / :\ X+ Je A X+ %
7 | RDB |« P\ ™ |je—ir N\ | Tx-
—I ! ! : \ v H Termination
\ L~ \ L resistance
1 [TERMRX f SG Y SG _|resistance
5 SG /R .
Shell I N
) User-created cable "
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2E)

e 1:1 Connection

Display side External Device side
Terminal block Shield  Terminal Block
i I N i Termination
Termination | Signal name ! ! ‘\ Signal name | resistance
istance*1 ! i 1200 1/2W
' resistance SDA ': /\! \ > RX+
Display ; / ,’\ |‘.
SDB ; T RX-
i oo
% RDA |[¢—i A TX+ %
] H H
——/ P\ TX-
Termination RDB ! P Termination
resistance*1 SG : — SG |resistance
: Lo 1200 1/2W
ERA i Vo
CSA (<t | |
Voo
ERB \ \ s
\‘ ‘\ ,:'
CSB |« eeeee j_
e 1:n Connection
Display side External Device side External Device side
Terminal block Shield  Terminal Block ~ Shield  Terminal Block
) K " ) / AN ) Termination
Termination | Signal name ! FA Signal name ,’I Y Signal name | resistance
' resistance*1 SDA ’.’ /\,"I‘.‘ o Rx+ / N ‘.. > RX+ 1200 1/2W
Display PN / / N
SDB : P RX- P RX-
% RDA fe—i //\ ' TX+ | A %
RDB |« \ TX- 4—".—/ ‘.\—."— TX- o
Termination \ Vo Termination
resistance*1 SG : SG % — SG [resistance
! Vo N \ 1200 1/2W
S N =+
CSA Voo
ERB :I Voo
CSB 1
*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 ON
2 ON
3 ON
4 ON
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2F)
e 1:1 Connection

Display side
::gsrirgtlgﬁlce Terminal block External Device
120 Q (12W) Signal name Shield Terminal block
; n
Sieoy TERM ; FAY Signal name
isplay ! AR Terminal
h H + H
RDA '. / \ T > resistance
|IE| RDB ; TX- 120 Q (1/2W)
SDA A RX+ Terminal
PFXZCBADTM1 { /\ resistance
SDB : — RX- 120 Q (1/2W)
|‘ 1 1
SG : — SG
L)
FG L N Y
User-created cable
e 1:n Connection
Display side
;Esrirgtigr?l:e Terminal block External Device External Device
120 Q (1/2W) Signal name Shield Terminal block Shield Terminal block
' TERM —,." FAY Signal name ,/’ FAY Signal name
Display RDA ! N >+ ! A X+ Terminal
7 / \ ! 7 /\ ) resistance
RDB TX- H TX- 120 Q (1/2W)
SDA A RX+ A Terminal
PFXZCBADTMI | /\ /AN i resistance
SDB : — RX- : — RX- 120 Q (12W)
SG + — SG — SG
FG L A% ‘! ........ Y
h User-created cable
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Cable Diagram 3

XGT/XGB Series Cnet Driver

Display
(Connection Port)

Cable

Notes

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

GP3000™ (COM1) +
AGP-3302B (COM2) 3A Terminal block conversion adapter by Pro-face
GP-4*01TM (COMI) CA3-ADPTRM-01
ST (COM2) +
LT (COM1) User-created cable
3B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
3C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000™3 (COM2) +
User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
3D .
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
. 3E Terminal block conversion adapter by Pro-face
IPC™ CA3-ADPTRM-01
+
User-created cable
3F User-created cable
GP-4106 (COM1) 3G User-created cable
GP-4107 (COM1)
GP-4*03T" (COM2) 3H User-created cable
GP-4203T (COML1)
RS-422 terminal block conversion adapter by Pro-face
. 3l PFXZCBADTM1"™
GP4000™® (COM2) +
GP-4201T (COM1) User-created cable
3B User-created cable

The cable length must
be 500m or less.

*1  All GP3000 models except AGP-3302B
*2 Al ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 O%the COM port which can communicate by RS-422/485 (2 wire) can be used.
"H IPC COM Port" (page 5)

*5  Except GP-4203T

*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T
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*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.

3A)
Display side External Device side
Terminal block Terminal block
Signal name Shield Signal name
RDA T A RX+
Displa ! i L
D CA3-ADPCOM-01 SDA i / \: ¥ > }
RDB : : RX-
UiH L S
CA3-ADPTRM-01 TERMRX _'.I‘_/II‘/_‘,'_ SG 120Q (1/2W)
SG ‘\ “‘ l"
FG I N, V)
- User-created cable -
3B)
Display side External Device side
D-Sub 9pin (socket) Shield Terminal block
. . ! e .
Pin  |Signal name i ,'"‘\‘ Signal name
Terminal ! i Terminal
resistance 1 RDA [¢ .' A" “. > RX+ resistance
120Q (1/2W) 3 SDA ! i \ T+ 120Q (1/2W)
Display i AN
2 RDB [« :' ! -: » RX-
] ! 1
7 | sbB P TX-
1 ]
5 SG H i : SG
[l H 1
4 ERA b
] ! H
8 | CsA &t i i
1 )
o |ERB [t %}
\ v
6 CSB [«% \/
\ [
Shell  |——%....¥
g o

User-created cable
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3C)
Display side External Device side
Terminal block Terminal block
Signal name Shield Signal name
RDA T A T RX+
Displa ; i1
P CA4-ADPONL-01 SDA : / i o }
RDB : : RX-
SDB A m—e Termtinal
i resistance
CA3-ADPTRM-01 TERMRX : L SG 120Q (1/2W)
SG f
FG I SO Y/
User-created cable
3D)
Display side External Device side
D-Sub 9pin (plug) Shie|q Terminal block
gl
Pin  |Signal name T A Signal name
H /\ ':' \ Terminal
2 RDA [« ,:' 4 “. » RX+ |resistance
3 SDA l¢ ! Al — 120Q (1/2W)
< T ! >
DisPlay ¢ a4-ADPONL-01 AW %
7 RDB |« : i > RX-
]
8 | sDB [+t i L TX
]
] ' ]
1 TERMRX f SG
[} \ ]
5 SG “‘ '\‘ ‘,’
!
Shell  —_——
= -
User-created cable
3E)
Display side External Device side
Terminal block Terminal block
Signal name ) Shield X Signal name Terminal
RDA R % TX+ resistance
Displa / AR 120Q (1/2W)
D CA3-ADPCOM-01 SDA / / \ '. Rt
RDB : : TX-
SDB [ RX-
CA3-ADPTRM-01 TERMRX g SG
SG f
Shell I . V)

Y

A

User-created cable
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3F)
Display side External Device side
D-Sub 9pin (socket) Shield Terminal block
Terminal - ) / n )
resistance | Pin  [Signal name ! A Signal name
1200 (1/2W) POAG D Terminal
) 1 DATA+ [« T ¢ > TX+ |resistance
Display % : \ 120Q (1/2W)
2 DATA- 4 A RX+
] H ]
3 | Nc P TX
H I
7 NC P H RX-
i ' i
5 SG : i : SG
| H :
4 ERA : b
1 \ ]
8 | csA i i |
9 | ERB Voo
\ Vo
6 CSB [} v/
I\ \ll
Shell -
g} >
User-created cable
3G)
Display side External Device side
Terminal block Terminal block
Termtinal o Signal name , Shield Signal name Terminal
resistance RDA 4 A ,"‘\ R TX+ resistance
Display { RDB H /\ N =~ 120Q (1/2W)
SDA ' '= RX+
]
SDB RX-
SG SG

ERA :l
CSA

ERB
CcSB :I

User-created cable

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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3H)
Display side External Device side
D-Sub 9pin (socket) Shield Terminal block
Terminal ) . ! I )
resistance Pin  |Signal name ! A ','\‘ Signal name
120Q (1/2W) P / [ Terminal
Displa 3 LINE+ [« ,:’ HID U TX+ resistance
play i | 120Q (1/2W)
8 LINE- i N TX-
) 1 1
T e S
i |
2 NC 5 | RX-
H [l
5 SG ' t SG
H [l
4 RS b
6 sV A
\ Voo
7 NC i (I
\ Vo
9 NC i v
Shell I W——
- -
User-created cable
3l)
Display side External Device side
Terminal Terminal block Terminal block
resistance | gignal name Shield Signal
120Q (1/2W) J / X fe ame
RDA y A—Le- TX+
Display RDB i / \ L TX-
= SDA ' ! RX+
\ SDB : RX-
PFXZCBADTMA SG G
TERM ;
FG o ooeeeee- W
-2

User-created cable

Terminal
resistance
120Q (1/2W)
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|

Cable Diagram 4

Display

. Cable Notes
(Connection Port)

GP3000 (COM1)
GP4000"! (COM1)
ST (COML1)

LT (COM1)

IPC™?

PC/AT

4A User-created cable
Cable length: 15m or less

GP-4105 (COM1) 4B User-created cable

*1  All GP4000 models except GP-4100 Series and GP-4203T

*2 O%the COM port which can communicate by RS-232C can be used.
"H |PC COM Port" (page 5)

4A)
Display side External Device side
D-Sub 9pin (socket) Shield Terminal block
Pin  |Signal name ‘,’f ','7‘\“ Signal name
Display ! cb :': ,"I ‘l‘: -
2 RD |« i ; ' ™>
3 | sD 4+ RX
4 | ER *
5 SG : SG
6 DR b
7 | Rs
8 | cs jedt L]
shell  |—%-V
- -
User-created cable
4B)
Display side External Device side
Terminal block Shield Terminal block
Signal name ,,’/ ,"7“" Signal name
Display | RD Je—t—i—1} TX
so ———+—+» Rx
SG SG
=1 ] O
cs eIy L/ -

User-created cable
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Cable Diagram 5

XGT/XGB Series Cnet Driver

Display
(Connection Port)

Cable

Notes

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

GP3000™ (COM1) +
AGP-3302B (COM2) 5A Terminal block conversion adapter by Pro-face
GP;4*01TM (CoM1) CA3-ADPTRM-01
ST (COM2) +
LT (COM1) User-created cable
5B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
5C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000™3 (COM2) +
User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
5D +
User-created cable
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
. 5E Terminal block conversion adapter by Pro-face
IPC™ CA3-ADPTRM-01
+
User-created cable
5F User-created cable
GP-4106 (COM1) 5G User-created cable
GP-4107 (COM1)
GP-4*03T" (COM2) 5H User-created cable
GP-4203T (COML1)
RS-422 terminal block conversion adapter by Pro-face
. . PFXZCBADTM1"™
GP4000™® (COM2) +
GP-4201T (COM1) User-created cable
5B User-created cable

The cable length must
be 500m or less.

*1  All GP3000 models except AGP-3302B
*2 Al ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 O%the COM port which can communicate by RS-422/485 (2 wire) can be used.
"H IPC COM Port" (page 5)

*5  Except GP-4203T

*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-4201T and GP-4*03T
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*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 5A.

5A)
Display side
Terminal block External Device side
Signal name Shield Terminal block Terminal
TERM £ /\ Signalname _|'esietance |
Displa / R
D CA3-ADPCOM-01 RDB ; / VR -
SDB —— +
nfR= o
RDA o SG
CA3-ADPTRM-01 SDA _;_T ™
SG 4 \ RX
FG I S V4
N User-created cable -
5B)
Display side External Device side
D-Sub 9pin (socket) Shield Terminal block
; >
Pin Signal name i ,’"\‘ Signal name
Terminal P H /\ ‘:' \ _
resistance 2 RDB [« i i v -
1200 (1/2W) | A
) 7 SDB : [ + )
Display ! o Ter_mtlnal
< 1 \ SG resistance
1 RDA .: :’ i 120Q (1/2W)
3 SDA T E i TX
] ] 1
5 SG P RX
| H 1
4 ERA b
1 ! H
8 |ocsA &t i i
\ H H
9 ERB | \ :‘
\ v
6 | CSB [« %\ \/
\ W}
Shell I N
- -

User-created cable
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|

5C)
Display side
Terminal block External Device side
Signal name Shield Terminal block
TERM /I A ,"l \ Signal name
Displa ! LA
P CA4-ADPONL-01 RDB i VI . %
SDB — +
! i Terminal
RDA T b SG resistance
CA3-ADPTRM-01 SDA - '.‘ :' X 120Q (1/2W)
SG i i RX
FG .Y
User-created cable
5D)
Display side
D-Sub 9pin (plu i
: P - (plug) /S_D_IQL(%‘ External Device side
Pin  |Signal name / ! \  Terminal block
] 1
1 |[TERMRX—H ¢ Y |Signalname
A
Displ 7 RDB [¢— 1 '; > - %
isplay ) ) ] N\
CA4-ADPONL-01 8 SDB |« : E : + .
1 ' | erminal
] 1 1 B
< \ \ 1 SG resistance
2 RDA i i ! 120Q (1/2W)
3 | SDA = X
\ \
5 | sG Voo RX
\ Al
Shell S A"
- -
User-created cable
5E)
Display side
Terminal block External Device side
Signal name Shield Terminal block
TERM —,"-l A /’l \ Signal name
Display RDB )\ LA R
CA3-ADPCOM-01 / VR }
SDB i L +
' oo Terminal
RDA H b SG resistance
CA3-ADPTRM-01 SDA | i i TX 120Q (1/2W)
SG \ \ / RX
FG I S ¥4

Y

A

User-created cable
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5F)
Display side External Device side
D-Sub 9pin (socket) Shield Terminal block
Terminal . ; ! " .
resistance | PN |Signal name ! A Signal name
120Q (1/2W) EVAVIR IR
2 DATA- [¢— —> - %
A
) 1 DATA+ . [ + :
Display ! ! 1 Terminal
3 NC i H ' SG resistance
i P 120Q (1/2W)
7 NC i ' \ TX
i ! i
5 SG oo RX
| H !
4 ERA : b
[} \ ]
8 | csA i i |
o |ERB [t % i
\ (]
6 CSB [¢«— \ \/
\‘ \'l
Shell -
g >
User-created cable
5G)
Display side External Device side
Terminal block Terminal block Terminal
Terminal Signal name Shield Signal name resistance
resistance *1 TR 120Q (1/2W)
RDB y 7 > -
Display RDA ! /\ VI T A
SDB ; SG
] ]
SDA ;' Pt X
SG 5 P RX
A [
1 ] !
CsA L
ERB R
C S B ] ‘\‘\ “‘\ II‘

-

User-created cable

The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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5H)

51)

Display

Display side
D-Sub 9pin (plug)

XGT/XGB Series Cnet Driver

External Device side

Terminal K - / " K
resistance | Pin |Signal name ! FA Signal name
120Q (1/2W) / /\ / “.
. 8 LINE- [« H > -
Display g i/ \" \ %

3 LINE+ :' ;' \ + Terminal
i H \ resistance

1 NC 5 ! ': SG 1200 (1/2W)

2 NC 5 N
H ! H

5 SG ! E E RX
1 ' ]

4 RsRTS) |

6 &\ A
i Voo

7 NC i (]
\ Vo

9 NC v

Shell I W
-t -
User-created cable
Display side
Terminal block External Device side
Signal name Shield Terminal block

TERM 7 /\ Signal name

A —2

SDB / — + _

| ! E Terminal
\ RDA ] ' .: SG resistance
PFXZCBADTM1 SDA t '.“ ': X 120Q (1/2W)
SG \ VS RX
FG I . V)

User-created cable
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6 Supported Device

Range of supported device address is shown in the table below.

XGT/XGB Series Cnet Driver

This address can be specified as system data area.

Device Bit Address Word Address 32bits Notes
Input / Output Relay P0O0000 - P2047F PO000 - P2047
Auxiliary Relay MO00000 - M2047F MO0000 - M2047
Keep Relay K00000 - K4095F K0000 - K4095
Link Relay L000000 - L11263F L00000 - L11263
Special Relay FO0000 - F2047F FO000 - F2047 1
Timer (Contact) TO000 - T2047 -
Counter (Contact) C0000 - C2047 - LIH
Timer (Current Value) - TOO00O - T2047 l;l
Counter (Current Value) - C0000 - C2047
Data Register - D00000 - D32767 @
Special Module Register - U00.00 - U7F.31 @ 2
Communication Data Register - N00000 - N21503
File Register - R00000 - R32767 @
File Register - ZR00000 - ZR65535 s F17°

*1  Write disable

*2  The feature of U device is as follows.

U7E.31.F

Bit Address (h0 to hF)
Special Module Inner Word Number: word number per slot (00 to 31)
Slot Number (h0 to hF)
Base Number (0 to 7)

*3  Not supported on XGB series.

-

Please note that the actually supported range of the devices varies depending on the External

Device to be used. Please check the actual range in the manual of your External Device.

« External Device has S and Z Device. But, XGT Cnet Protocol does not support it.

¢ Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
» Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

Device Device Device Code Address Code
Name (HEX)
Input / Output Relay P 0080 Word Address
Auxiliary Relay M 0082 Word Address
Keep Relay K 0083 Word Address
Link Relay L 0084 Word Address
Special Relay F 0085 Word Address
Timer (Current Value) T 0060 Word Address
Counter (Current Value) C 0061 Word Address
Data Register D 0000 Word Address
Special Module Register U 0002 Word Address”™t
Communication Data Register N 0064 Word Address
File Register R 0001 Word Address
File Register ZR 0003 Word Address

*1  Internally "Address Indirect specification" is supported in case of U device.
When it is Uxx.dd, the converted formula is like this:
Hex type: ["xx" part] x h20 + [the hexadecimal value of "dd" part]
Dec type: [the decimal value of "xx" part] x 32 + ["'dd" part]
(Here, "xx" is also a hexadecimal type, "dd" is also a decimal type.)

For example, "01.00" is converted into "0x20 (=32)", "10.00" is converted into "0x200 (=512)",
"7F.00" is converted into "OxFEO (=4064)" and so on.
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error
Occurrence Area)". Each description is shown below.

Item Description

No. Error No.

Name of External Device where error occurs. Device name is a title of External Device set

Device Name with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

Error Occurrence Area NOTE

« IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
« Device address is displayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal [Hex]".

Display Examples of Error Messages
"RHAAOQ35:PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE » Refer to your External Device manual for details on received error codes.
« Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the

error messages common to the driver.
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